Extended PO Entry SmartFinder — Purchase Orders

Extended PO Entry

Extended PO Entry is an enhanced replacement for the Sage Purchase Orders Entry form. It provides
you with more information while entering a PO and fast access to additional PO, Vendor, and Item
information.

The following pictures show some of the extra features on the Extended PO Entry screen:

Sage Purchase Order Entry screen TaiRox Extended PO Entry screen
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Click the following links for details on each Extended PO Entry feature:

SmartFinder — Purchase Orders Finds purchase orders and shows PO details quickly for any vendor.
SmartFinder — Vendors Find a vendor quickly from a name, description, phone number, or address.
SmartFinder — Items Find an item quickly from partial item number or description. Search also by
manufacturer’s item number with the Enterprise version of Productivity Tools.

SmartFinders provide fast, browser-like search capabilities for looking up data on the PO Entry
screen. They search more fields than the Finder, and search in all text fields at once. For
example, search for “Seattle” if you think that the vendor or contact is in Seattle.

Vendor Inquiry (button left of the vendor name field) provides complete vendor data, including POs,
receipts, purchases, requisitions, invoices, payments, adjustments, etc.

Vendor Optional Fields Display any vendor optional fields on the Extended PO Entry screen.
Quantities Display Show item quantities at the bottom of the standard PO entry window - the same
item quantities that are displayed in the Sage 300 Order Entry module.

Item Quantities Display quantities available at other locations or in other companies while entering a
purchase order.

Update Order Update the expected arrival date or vendor cost of an item, or substitute items on a PO.
Drop Ship Drop ship dozens of purchase order detail lines in a single operation.

Line Finder Quickly find a detail line in a large order by item number, location, order number, or
vendor item number.

Purchase from History Create a new purchase order for a vendor based on what has been previously
purchased from that vendor.

Prepayments View the details of any prepayments entered for the current vendor and purchase order.
Quick PJC Entry Default newly inserted lines to have the same Contract, Project and Category
selections as the previously entered line.

Note: You may need to widen the Extended PO Entry screen to see all of the Sage 300 and TaiRox
Productivity Tools buttons at the bottom of the screen. Click the Maximize button to see all features.
ey
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Extended PO Entry SmartFinder — Purchase Orders

SmartFinder — Purchase Orders

Click the PO Number button to open the SmartFinder for searching purchase orders. | FO Number

Search:
e Enter one or more words or word fragments in the entry field to search multiple tables and fields.
e You can filter by purchase order type and include completed and on-hold purchase orders.

e Search returns records which contain the search string in any of the searched fields — for
example, one record may have “Royal” in the name, where another may have it in the address
field. Both will be displayed.

o Using multiple words in the search? Enter "300 Main" and the search will find entries "300
Main Street" as well as "123 Main Street, Suite 300".
o Searching for a phone number? Enter the phone number segments separated by blanks.
Enter "451 8991" and the search will find "(451) 555-8991" as well as "(408) 451-8991".
Note:

o All of the word fragments must be present in one of the fields being searched. (For example,
if you searched for “Ross Blvd”, you will not see a PO where “Ross” is in the Vendor Name
field and “Blvd” is in the Address 1 field.)

o Addresses (e.g. the vendor address) are treated as a single field.

Display:
e The top grid displays the POs matching the search criteria. Double-click to select a PO.

e The bottom grid displays the details of the purchase order highlighted in the top grid.

e Click the Address 1 column heading or double-click the address to launch Google Maps with the
vendor address. You can also check the locations of Ship-To and Bill-To addresses.

e Double-click email addresses (such as the Contact E-mail) to create new emails.

2 PTDEMO - Extended PO Entry |E=H EoE =)

File Help

Orders [ include Purchase Orders on Hold

B Address 1
342 Central Park
=g

PODOD000008 =
PODDDODO00S  Active 4500 Leon Industies 342 Central Park
PODDDODODI0  Active 4500 Leon Industies 342 Central Park

1132019

AT-400/0 Desk Note Book 1 Ea
A1-401/0 Desk Calendar .. 1 Es 11372019
A1450/0 Bulletin Board 1 E= 11372019
A470/0 Dyyerase White .. 1 200 Ea 11372019
A1650/0 Highighter 1 Ea 11372019
A1655/0 Fen 1 Ea 11372019

o
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Extended PO Entry SmartFinder — Vendors

SmartFinder — Vendors

Click the Vendor Number button to open the SmartFinder for searching vendors. | Vender Number

Search:
e Enter one or more words or word fragments in the entry field to search multiple tables and fields.
e You can also filter for Active vendors.

e Search returns vendors and remit-to location records which contain the search string in any of the
searched fields — for example, one record may have “Royal” in the name, where another may
have it in the address field. Both records will be displayed.

o Using multiple words in the search? Enter "300 Main" and the search will find entries "300
Main Street" as well as "123 Main Street, Suite 300".

o Searching for a phone number? Enter the phone number segments separated by blanks.
Enter "451 8991" and the search will find "(451) 555-8991" as well as "(408) 451-8991".

Note:

o All of the word fragments must be present in one of the fields being searched. (For example,
if you searched for “Ross Blvd”, you will not see a vendor where “Ross” is in the Vendor
Name field and “Blvd” is in the Address 1 field.)
o Addresses (e.g. the vendor address) are treated as a single field.
Display:
e The top grid displays the vendors matching the search criteria.
e The bottom grid displays the remit-to locations that match the search criteria.

Note that the remit-to locations may not be related to the vendor records displayed in the top part
of the screen. The screen below displays remit-to locations for two different vendors.

e Click the Address 1 column heading or double-click the address to launch Google Maps with the
vendor address. You can also check the locations of Ship-To and Bill-To addresses.

e Double-click email addresses (such as the Contact E-mail) to create new emails.

[ [

Selection:
o Double-click a vendor in the top grid to select and enter the vendor on the purchase order.

e Double-click a remit-to location in the bottom grid to add the vendor and this remit-to address to
the purchase order.
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Extended PO Entry SmartFinder — Items

SmartFinder — Items

Click the Item Finder button under the item grid to open the SmartFinder for items.

The Item Finder provides several item search options and displays search results in a selection grid with
columns such as description, alternate item number, stock item flag, or sellable flag. You can select which

columns are displayed.

File Help
Manufacturer's tem Humber

Find tems By
[ Search ~] T |

Location B | [Portland Ofice |
[ Active ems Only

Structure Code | Category Stock tem

[H tem Number | Description Comment 1

e The ltem Finder appears with the “Search” selected by default on the Items tab. This is the most
common way to look up items.

o Type a partial item description or item number in the text field, optionally select Active Items
Only, and press Enter to immediately search for items.

e Alternatively, select a different “Find Items By” choice from the Find Items By dropdown. For
example, you can choose “Show All Records” and specify a range of item numbers, structure
codes, categories, or account sets using the range fields. You can specify more selection fields
using Additional Criteria.

File Help

ltems  Manufacturer's ltem Number

Find kems By
[ Show All Recards ~]

tem Range

Select tems By From To

[ hem Number | [A1-105/0 | [prose fe!

[ (Nre) v]

[ tNore) ]

[ None) ]

Addtional Criteria Reset Defaults

Location [ | [Portiand Office

e The above search screen displays two tabs for looking up inventory items — ltems and
Manufacturer’s Item Number — which let you search for I/C item numbers or for manufacturer’s

item numbers.
Search for manufacturer’s item numbers is a Productivity Tools Enterprise feature.
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Extended PO Entry SmartFinder — Items

The Manufacturer’s Item Number tab will not appear unless you have a license for the Enterprise
version of Productivity Tools.

If you do not select the SmartFinder “Search” option, you can select up to four item field ranges —
by item number, status, structure code, category code, and account set code.

The item price is the quantity zero price for that customer.

The Item Finder also displays all columns that are in the standard Sage Finder. You can choose
which columns appear in the Item Finder by selecting File > Settings from the Item Finder menu.

Selecting an item inserts a new row into the PO entry grid.

Searching for Inventory Control Item Numbers on the Items Tab

The Item Finder on the Items tab provides 7 search options:

File

Help

ltems  Manufacturer's ltem Number

Find ltems By

Search [+] [ |

i
I

TaiRox Productivity Tools for Sage 300

Show Al Records
tem Number |Pnrtland Offics \

Description
Structure Code

Status | Comment 1 Structure Code

Search (most common option) — to search for words or word fragments in item text fields (such
as the item number, item description, structure code, category, price list, picking sequence, and
comments). This search works like the PO Number and Vendor Number SmartFinders.

Show All Records — to select items from all item records based on ranges of Iltem Number,
Structure Code, Category, and Account Set Code and on item Status. You can also specify
additional selection criteria to use more item fields.

Iltem Number — to select items using part of the item number. You can refine your selection
based on ranges of Item Number, Structure Code, Category, and Account Set Code, select items
by item status, and specify additional selection criteria using more item fields.

File Help

tems  Manufacturer’s fem Number
Find fems By

[ hem humber ~ | [ Starts with | |
Starts with
tem Range

Search by Item Number, Description, Structure Code, Category and Account Set Code also let
you specify a search value that the item starts with or contains.

Note that the “Search” choice automatically looks in these fields and looks at all characters in text
fields.

Description — to select items that begin with or contain a string of characters. You can refine
your selection based on ranges of Item Number, Structure Code, Category, and Account Set
Code, select items by item status, and specify additional selection criteria using more item fields.

Structure Code — to select items with structure codes that begin with or contain a string of
characters. You can refine your selection based on ranges of ltem Number, Structure Code,
Category, and Account Set Code, select items by item status, and specify additional selection
criteria using more item fields.

Category — to select items in categories that begin with or contain a string of characters. You can
refine your selection based on ranges of Item Number, Structure Code, Category, and Account
Set Code, select items by item status, and specify additional selection criteria using more item
fields.
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Extended PO Entry SmartFinder — Items

Account Set Code — to select items with codes that begin with or contain a string of characters.
You can refine your selection based on ranges of Item Number, Structure Code, Category, and
Account Set Code, select items by item status, and specify additional selection criteria using
more item fields.

More on the “Search” option (most common option):

File

Help

ltems  Manufacturer's ltem Number

Find ltems By

gl \

Location [ | [Portand Cffice |
[ Active kems Only

Select Find Items by Search. (Note that Find Items By defaults to the last choice used.)

Enter one or more words or word fragments in the next field to search multiple item tables and
fields. (Note that the program scans all columns displayed by the Item Finder.)

You can filter for Active items only.

Search returns items and vendor item numbers that contain the search string in any of the
searched fields — for example, one record may have “Desk” in the Description field, where
another may have it in the Comment 1 field. Both items will be displayed.

o Using multiple words in the search? Enter "300 Main" and the search will find entries "300
Main Street" as well as "123 Main Street, Suite 300".

o Searching for a phone number? Enter the phone number segments separated by blanks.
Enter "451 8991" and the search will find "(451) 555-8991" as well as "(408) 451-8991".

Note:

o If using the Search option, all of the word fragments must be present in one of the fields that
are displayed on the screen. (For example, if you search for “desk lamp”, you will not see an
item where only “desk” is in the Description field and only “lamp” is in the Comment 1 field.)

Display:

The top grid displays the items matching the search criteria. The screen below shows “Desk
Lamp” in the description of one item, and “Desk Lamp” in the comments of the second one — so
both appeared.

The bottom grid displays any entered vendor item numbers for the item selected in the top grid.

Vervdo lem Nurmber
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Extended PO Entry

Selection:

SmartFinder — Items

e Double-click an item in the top grid to select and enter the vendor on the purchase order.

e Double-click a vendor item number to enter the item number and the vendor item number into the

PO form.

Selecting columns to display — and scan —in the Item Finder

Choose File > Settings in the Item Finder window to change column settings.

_

File Help

Close

Settings..
Reset Defaults

[ Active tems Only

~
Atemate tem Set Number
Description

Date Last Maintained

Status

Structurs Code

Category

Accourt Set Code

Stock fem

Stocking Unft of Measure
Defaut Price List Code

Unit Weight

Defaut Picking Sequence
Serial Numbers

Commodity Number

Date Inactive

Segmert 1

Segmert 2 v

< Exclude

Al->

Qty. Available
Gy, Available (Al)
Manufacturer Number
Prefemed Vendor tem
Preferred Vendor

[ rouces | [
Manufacturer's ltem Number
Manwfacturer's tem Description

[The mazimum number of columns is 60. selected is 8 |

oK

Up

Down

Cancel

e The current columns that are displayed appear in the right-hand column.

¢ Highlight columns that you want to add in the left-hand column and click the Include button.

e Settings apply to the currently selected tab. For example, if you want to change the columns
on the Manufacturer’s Item Number tab, choose the tab first, and then select File > Settings.

e Only the “Included Fields” are used for searching. For example, if you do not include the

Comments 1 field, the program will not scan the comments. Also note, that the number of fields

will affect performance. If search is slow, remove columns that you don’t need.

All of the possible columns are shown below. Note that optional and calculated fields are also available
for inclusion — for example ltem’s Color and Qty. Available for Sale.

ke Numoer

~
Attemate ftem Set Number
Description

Date Last Maintained

Status

Structure Code

Category

Account Set Code

Stock tem

Stocking Unit of Measure
Default Price List Code

Unit Weight

Default Picking Sequence
Serial Numbers

Commedity Number

Date Inactive

Segment 1

Segment 2 A

< Exclude

Al >

< None

Manufacturer’s tem Number
Manufacturer's tem Description
Gity. Available

City. Available (All}
Manufacturer Number
Prefered Vendor tem
Preferred Vendor

The: maximum number of columns is 50, selected is 8

0K

Up

Down

Cancel

Comment 2 -
Comment 3

Comment 4

Alow lem in Web Store
Kitting ftem

Optional Fields

Default Kit Number

Weight Unit of Measure
Unfomatted Altemate tem
Altemate ltem Number
Altemate tem Description
Costing Method

Process Command

‘Weight Conversion Factor
Is ltem @ BOM Component
Serial Number Mask

Next Serial Number

Use Serials Days to Expire ™

[ |

Serials Days to Expire

Allow Different Serial Gty
Serials Cptional Fields
Default Serial Warranty Code
Default Serial Cortract Code
Serial is on Cont. When Rec
Serial is on Wam. When Solc
Serial is on Warr. When Rec
Lot Mumber Mask

Next Lot Mumber

Use Lots Days to Expire
Lots Days to Expire

Use Lots Days on Quarantin
Lots Days on Quarantine
Allow Different Lot Gy

Lots Optional Fields

Default Lot Wamanty Code
Default Lot Contract Code

-

Lot is on Cont. When Recein
Lot is on War. When Sold
Serial Numbers in Use

Serial Mask Structure

Serial Mask Description
Unformatted Serial Number
Serial Number

Auto-gen Serial Number
Mumber of Serials to Geners —
Number of Serials not Gener
First Generated Senal

Last Generated Serial

Lot Numbers in Use

Lot Mask Structure

Lot Mask Description
Unformatted Lot Number
Lot Number

Auto-gen Lot Number =2

Number of Lots to Generate »
Number of Lots not Gengrate
First Generated Lot

Last Generated Lot

SIA Prefemed Vendor Type
Default BOM Number
Seasonal?

Gty. on Hand

Gty on Purchase Order
Qty. on Sales Order

Gty. Available

Gty. Committed

Prefemed Vendor

Prefemed Vendor kem

ttem’s Calor

Dangerous tem

Extended Wamanty Available
ttem Type =2

[ |

ltem Lead Time
Manufactursr
Manufacturer Number
New ltem

Price

ltem Procurement

ltem Size

ltem Valume

Warranty

Wamanty Period

Gty. On Hand

Gty. On Purchase Crder
City. On Sales Order

Gty. On Hand {All)

Gty. On Purchase Order {All)|
City. On Sales Order (All)
Stocking Unit of Measure
Gty. Committed

Qty. Committed (All}

Qty. Available for Sale
Qty. Available for Sale (All)
Base Price (CAD)

Pricing Unit

q [Lm |
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Extended PO Entry SmartFinder — Items

Searching for Iltems on the Manufacturer’s ltem Numbers Tab

Note: The Manufacturer’'s ltem Number tab will not appear unless you have a license for the Enterprise
version of Productivity Tools.

Search for manufacturer’s item numbers is a Productivity Tools Enterprise feature.

Eile Help

kems Manufacturers tem Number
Find kems By
Search |v |

Manufacturer’s kem Number
Manufacturer's kem Description
Search

[E tem Mumber | [B] Manufacturer's tem Number | Manufacturer's tem Description | Gty. Available | [B Qty. Available (All) | Manufacturer N...

e The Manufacturer’s Item Number Finder appears with “Search” selected by default. This is the
most common way to look up items by manufacturer’s item numbers.

o Type a partial item description or item number in the text field, optionally select Active Items
Only, and press Enter to immediately search for manufacturer’s item numbers.

o Alternatively, select “Manufacturer’s ltem Number” or “Manufacturer’s Item Description” for
searching.
The Item Finder on the Manufacturer’s ltem Number tab provides 3 search options:

e Search (most common option) — to search for words or word fragments in manufacturer’s item
text fields (the manufacturer’s item number or the manufacturer’s item description).

This search works like the PO Number and Vendor Number SmartFinders.

¢ Manufacturer’s Item Number — to select items using part of the manufacturer’s item number.

File Help

ftems  Manufacturer’s hem Nomber
Find fems By

[ Manufacturer's fem Number | [ starts with [
Starts with
[ Active ems Oniy

You can specify that the item number starts with or contains the string that you enter.

¢ Manufacturer’s Item Description — to select items using part of the manufacturer’s item
description. As with the item number, you can specify that the item description starts with or
contains the string that you enter.

Note that the “Search” choice automatically looks in the manufacturer’s item number and the
manufacturer’s item description fields.
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Extended PO Entry Vendor Inquiry

Vendor Inquiry

Vendor Inquiry button displays the TaiRox Productivity Tools Vendor Inquiry screen — a convenient way to
view data related to the vendor. Each tab focuses on an aspect of the vendor’s data.

You can also look up details for other vendors while you are on this screen.

PO Number | |4 4 b M Q +

Vendor Number | 1280 | ) = . |G|T:|r|t Office Supplies |

PTDEMO - Vendor Inguiry
File  Settings  Help

VendorMo. | |4 4 | e L‘|Gmm0ﬁice5upplies | Vendor Curency

Pending Reguisiions POs PO Receipts PO Invoices PO Retums POCR/DR  Purchases Aging lems
Profile  Address Comments Optional ids. Remit-To Recur. Payables  Activity Documerts Payments Adjustments

Legal Name | | Last Maintained  |{08/18/2010
Group Code |\NV | ||nventnry Purchases | Active II
Account Set |USA | |Accoums payable, Other | On Hold

Rate Type

Bank Code |SFJ\TAC | |Seart|e Tacoma Bank |
Paymert Code |CHECKUSD | |USD check Seattle Tacoma Bank |
Check Language l:l

Dilivery Method

T DUETBL Due by Invoice Date |

Retainage Terms

Retention Period
Tax Group |mL|F | |Ca|ifomia State Tax Group |
Tax Authority Authority Descri... Tax Class | Class Description Registration Mumber Tax Included
STATE State Tax 1 Taxsble tem No
COUNTY County Tax 1 Taxable merchandize Mo
Vendor Account Status

Outstanding Balance

No. of Open Invoices El
ot [

Prepayment Amount

B
2
a

Qutstanding Retainage

Credit Limit 1,000.00
Befresh
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Extended PO Entry Vendor Optional Fields

Vendor Optional Fields

If you use the Sage 300 Optional Fields module, you can display any optional fields from the A/P vendor
record on the right side of the Extended PO Entry screen.

SAMLTD - Extended PO Entry

File Help  P/O Purchase Order Entry

PO Number | |4 4 [POD00DDOO1S P QO+ Entered By [ADMIN
Order Taxes Optional Fields Rates Totals * Required
Template 1] [ClFrom Requistion | [J0n Held Job Related ——

PO Date 20200123 FOBPon:  [Seatte WA vl Dae [ - e | el
Note Make sure you get the PO 2
PO Type Vendor's Putchasing Representative

. Vendor Class Miscellaneous Expense Purchases
Ship-To Location 1B SV |CTL | ) ‘Cmss{uumw Trucking Lines

This lets you view notes concerning the account during data entry, and also view PO requirements.

You specify which optional fields to display on the Extended PO Entry screen using the Productivity Tools
Options program.

Setting Up Optional Fields on the Extended PO Entry Screen

You choose the vendor optional fields to display on the Extended PO Entry screen and Extended PO
Receipt Entry screen using the Productivity Tools Options program on the Sage 300 Desktop.

The following example shows the vendor optional fields that will appear on the Extended PO Entry
screen.

SAMLTD - Options

File Help

Menu  fem Quantities Order Entry  Purchase Orders

Receipt Must Have a Purchase Order Number Vendor Optional Field REQPO )]

Leave the Vendor Optional Field blank if @ Purchase Order Number is required for all vendor receipts. Select a Yes/No Vendor
Optional Field name to control this option by vendors.

Purchase Order/Receipt Vendor Optional Fields To Display

Include -» Reguire PO Number on Receipts Up
Accounts Payable Contact Type Mate

Disc Level ~ Vendor's Purchasing Representative

Discount Grace Period FEZLE Vendor Class Doy
Due Date Grace Period =

SAMLTD - Extended PO Entry

File Help  P/O Purchase Order Entry

ones 4 ApoMEmT |y Q+ o
Order Taxes Optional Fields Rates  Totals * Required
T |:| From Requision [ J0n Hold Job Related Optional Field Value
s oo | T P [ e | O e
° s e o ‘ e =l (i Note that vendor bils 1
PO Type Vendor's Purchasing Represent... Vsena Strong
_ Vendor Class Senvice Provider
SpTolscaton | | b Sheli \ Q|
Bil-To Location |:| {5 TemsCode® [PUETBL |Q [pue by invoice Date
TaiRox Productivity Tools for Sage 300 10
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Extended PO Entry Quantities Displayed on the Extended PO Entry screen

Quantities Displayed on the Extended PO Entry screen

Extended PO Entry displays item quantities for the selected location and item at the bottom of the PO
Entry window — like the quantities displayed on the Sage Order Entry screen.

The program also provides drill-down links for quantities on sales order, quantities on purchase order,
and committed quantities.

Note that the screen below shows the single location displayed for the current line item in the grid, as well
as a total for all locations.

You can change the display to include item quantities for multiple locations in multiple companies.

SAMLTD - Extended PO Entry

Flle  Help  P/O Purchase Order Entry

PO Number | [4 4 [POD0D000D1S [» ¥ Q+ Entered By ADMIN
Vendor Number | 1200 = [Chioride System Last Recsipt No |:|

* Required

Order Taxes Optional Fields Rates Totals

[[]From Requistion g []0n Hold Job Related Optional Field

l

Template

PO Date 20200123 FOB Paint ‘Seattle. WA Anival Date l:l Require PO Number on Receipts Yes
Naote Make sure you
PO Type Vendor's Purchasing Representative
Vendor Class Miscellaneous E
Ship-To Location {0 Ship-Via ‘CTL ‘ )] ‘Cmss{oumw Trucking Lines
o

Bil-To Location 3 Tems Code * N30 [Net 30 Days ‘
Vendor Acct. Set * ‘USA | 3 |Accuunls payable. Other ‘
Description ‘Slandlng order for Ms. Adams ‘ R ‘Jan 2010FO ‘ < )

. | Completed | @ tem Number ltem Description Q, Unit Cost | Extended Cost Discount % Discount Amount [kl
Fluorescent Desk Lamp 3 19.990000 299.85 0.00000

2 No A1-105/0 13W Mini Fluorescent Bub 4 No 20 Ea 3350000 67.00 0.00000 0.00
v
< >
tem/Tax... | | Calc. Taxes | | Consolidate Set Arival Date Set Location Update tem Finder Drop Ship Line Finder 36es|[UsD |
Post Delste Histary.... Purchase From History... Prepayments... Close
Gty.On Hand ~ Gty. On Sales Order  Qty. On Purchase Order Gty. Committed Qty. Available
Location 1 (Ea ) 137 15 [B 250 [H 0 137
Al Locations (Ea.) 657 8 (M 426 [4 0 €57
TaiRox Productivity Tools for Sage 300 11

© 2009-2024 TaiRox Software Inc. All rights reserved.



Extended PO Entry Displaying Quantities for multiple locations and companies

Displaying Quantities for multiple locations and companies

Extended PO Entry can also display item quantities available at other locations — either at the bottom of
the Extended PO Entry screen or in a separate window.

To display quantities for multiple locations and companies:

o Select the Extended PO Entry > File > Settings menu choice to change the Item Quantities

display settings.
2/ PTDEMO - Extended PO Entry Settings =)
Disolav ftem Quantites Display on Separate Screen -
Do Mot Displa
[ Save ] Display on Entry Screen
Display on Separate Screen

o Do Not Display — shows only total quantities and quantities for the current line item location.

Pogt Delete [ History.. ] [Purchase From History. ] [ Prepayments... ]
CQty.On Hand  Gty. On Sales Order  Gty. On Purchase Order Qty. Committed Cty. Available
Location 2 (Ea.) 262 9 H 0 0 262
Al Locations (Ea.) 657 23 [8 276 [ 0 657

o Display on Entry Screen — includes a new grid at the bottom of the screen that displays
guantities at all locations, in the current company and any associated companies.

Qty.On Hand  QGty. On Sales Order  Gty. On Purchase Onder Qty. Committed Qty. Available
Location (Ea)} ] 0[4 ] 1} 1}
All Locations (Ea.) 657 2[5 276 [4 0 657

Database 1D Location Description ltem Number Description Stocking Unit Gty. On Hand | Gty. On Purcie
SAMINC Sample Compan... 1 Central warehou...  A1-103/40 Fluorescent Des... Ea. 137 [
SAMINC Sample Compan... 2 Portland Office A1-103/0 Fluorescent Des... Ea. 262 -

4| 1 | *

o Display on Separate Screen — displays the item quantities at all locations in a separate
window. (The image below shows the window widened to display most of the quantity
columns.)

Click the All Locations button to move the Quantities in front of other windows (if hidden).

The All Locations button appears at the bottom of the Extended PO Entry screen if you
choose to display quantities on a separate screen.

Item Quantities will be refreshed as you move to other detail lines.

TaiRox Productivity Tools for Sage 300 12
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Extended PO Entry

Selecting which companies and locations are displayed

Displaying Quantities for multiple locations and companies

An administrator must first set up the Sage 300 company databases and locations that are displayed in

the ltem Quantities grid.

e Goto TaiRox Productivity Tools > Options, and click the ltem Quantities tab.

PTDEMO - Options

User ID

File Help

Menu  ttem Quantities
Database ID | Description
SAMLTD Sample Company Limited sa
SAMINC Sample Company Inc. =3
SAMINC Sample Company Inc. sa
SAMLTD Sample Compary Limited =3
PTOEMQ |~/ Productivity Tools Demao sa
CHKWAN
CPYINC
CPYLTD
PTCOPY
PTDEMO

o Use the Insert and Delete keys to add or remove locations and companies from the Iltem

Password
pass1234
pass1234
pass1234
pass 1234

Location

MR =

Quantities grid and to change the order that locations appear.

Each user can customize the item quantities grid by hiding and moving columns to suit their own needs.

For example:

e You can hide the Database ID and Name columns if all locations are in the same Sage 300

company.

e You can also hide the Item Description and Stocking Unit if these are the same at all locations.
Hide and re-arrange columns by dragging and dropping.

PTDEMO - Item Quantities

Qty. On Sales Order | Gty. Available

8 143
] 75
] 50

CER-NCR S

File  Help
Location | Description ftem Number Gity. On Hand | Gty.On Hand (All) | Gty. On Purchase Order
Central warehou...

2 Portland Office A1-105/0 143 0
3 Newark, New Je.. A1-105/0 75 150
4 Port of Vancouver  A1-105/0 50 250
4| [

Befresh

TaiRox Productivity Tools for Sage 300
© 2009-2024 TaiRox Software Inc. All rights reserved.
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Extended PO Entry Updating Purchase Order Lines

Updating Purchase Order Lines

The Extended PO Entry Update window lets you update multiple item lines at a time.

Click the Update button to display the Update Lines pop up window.

The top portion of the form has the same options as the standard Update Purchase Orders form.

[ )
e The bottom of the form displays a log of item changes when the update is processed.

[ESSEE===)

-
# SAMLTD - Update Lines

File Help
Update Crder
Update tem Expected Amival Date | Ligt Of kems - [H
Update ttem Expected Amival Date

Update ttem Vendor Cost
Substitute tems

Update Purchase Order Amival Date Also

Frocess Close

e

Choose what to update — expected item arrival date, item vendor cost, or
substitute items:

Update Order
Update tem Expected Amival Date w | List Of ltems

Update tem Expected Amival Date
Update tem Vendor Cost
Substitute tems

You can select three types of updates:
o Update Item Expected Arrival Date

e Update Item Vendor Cost to match new costs in I/C Vendor Details

e Substitute ltems

TaiRox Productivity Tools for Sage 300
© 2009-2024 TaiRox Software Inc. All rights reserved.
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Extended PO Entry Updating Purchase Order Lines

Updating the Item Expected Arrival Date

Update Order
Update tem Expected Amival Date ¥ Specffic tem -
em Number [A1-103/0] |} [Fuorescent Desk Lamp

Expected Amival Date 09/26/2022

Update Purchase Crder Amival Date Also

e Specify the new Expected Arrival Date. The above screenshot shows the date update for a
specific item.

e Select “Update Purchase Order Arrival Date Also” to update the Arrival Date for the complete
purchase order as well.

Updating the Item Vendor Cost

The program updates the vendor costs on the PO with the costs stored in I/C Vendor Details.

Update Order
Update ltem YWendor Cost *  Specffic tem -
tem Mumber A1-103/0 | @ [Auorescent Desk Lamp

e Specify an item number, list of item numbers, or all items.
e The program will update the vendor costs from I/C Vendor Details.

Substituting Items

Note: The program will not substitute items for a completed or partially shipped line, or for lines that
have an Order Entry order number reference.

Also, we suggest you take care when substituting non-inventory items due to issues with units of
measure and UOM conversion factors with non-inventory items. We suggest you use the stocking
units of measure — if both are the same, you will not have an issue. Make sure to check the units of
measure and extended costs for all substituted items when processing is finished.

r |1

# SAMLTD - Update Lines [o/@] = |

File Help

Update Order

Substitute tems w | List Of kems
[| Retain Bxisting Line ttem Unit Cost /

# SAMLTD - Extended PO Entry ‘ [E=gEE

Q. From tem Mumber | ttem Description Q, To tem Mumber ltem Diescription

A1-103/0 A1-310/0 Halogen Desk Light

e Select Substitute Items from the dropdown list.

o To specify the substitute items list, click the Zoom button beside the dropdown, and add “From”
items and “To” items to the list in the form that appears.

o Use the Finder to look up items. Use the Insert key to add new empty lines.
e Choose whether you want to “Retain Existing Line Item Unit Price.”

TaiRox Productivity Tools for Sage 300 15
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Extended PO Entry Updating Purchase Order Lines

Choose a single item, list of items, or all items:

If updating the expected arrival date or the vendor cost, you can choose to specify a single item, all
items, or a list of items. If you select “Substitute Items, you must use the item list popup to specify the
item or items that you want to substitute.

e If you use the list popup form to specify a list of items, the list will be remembered from the
previous time you used it to update a PO.

e To create/edit an item list. click on the Drill Down icon on the right side of the dropdown field.

% SAMLTD - Update Lines (=[=] = |
File Help
Update Order
Update tem Expected Amival Date v  List Of ltems v
Expected Arival Date 09/26/2022 /
d % SAMLTD - Extended PO Entry / S

Q, ltem Mumber ltem Description

A1-105/0 13W Mini Auorescent Bulb
13W Mini Fuorescent Bulb

To insert items:

Use the Insert key to add more items to the list.

Use the Delete key to remove items.

The list will be remembered from the previous time you used it to update orders.
Click the Reset Defaults button to delete all items from the list.

O O O O

To import a list of items or item substitutions:

o Click the Import button at the bottom of the popup form and select the spreadsheet containing
the item list.
» The imported list will replace the current list of items.

o Use the Insert key to add more rows to the list.

o Use the Delete key to remove items from the imported list.

o Click the Reset Defaults button to delete all items from the list.

Import format:
You can find sample import files in directory \Sage300\XL61A\Documentation.

Note: The Excel Spreadsheet for an item list (Items.xIsx) is a single column with “ITEMNO” as
the column heading in the first row.

A
1 |ITEMNO
2 |A11030
3 |A11050

TaiRox Productivity Tools for Sage 300 16
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Extended PO Entry

Click the Process button to update purchase orders

Click the Process button at the bottom of the screen to update purchase orders. The program will
display progress messages as it updates lines and tell you when it is finished.

Extended PO Entry -

A

Are you sure you want to update this purchase order?

| ves || e

J

~

Depending on your permissions, you may need to have price changes for items approved by a

supervisor.

TaiRox Productivity Tools for Sage 300
© 2009-2024 TaiRox Software Inc. All rights reserved.
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Extended PO Entry

Using the Extended Drop Ship wi

The Extended PO Entry Drop Ship window lets you d

Using the Extended Drop Ship window

ndow

rop ship multiple items at a time.

Click the Drop Ship button to display the Drop Ship pop up window.

The grid at the bottom displays the Purchase

The top portion of the form is the same as the standard Drop Ship form.

detail lines.

% PTDEMO - Drop Ship
File Help

Set Drop Shipment Address to  Customer Ship-To Address
( J[1200

Customer Number

Ship-To Location

Description

Address

WAREHS Q

===

|Warehouse

|Fleceiving Dock 17

|‘Nabash Industrial Park

|‘Nabash State

City

Zp/Postal Code  [V3W2H2 Courtry [usa

Phone Number || ) - ‘ Fax Number |‘:) -

Location E-mail

Contact

Contact Phone

Contact Fax

Contact E-mail

Location

Double Pedestal 71in X 1
| Kugg 250 Am TiterFust 11|
2300 Series Posture Chair 1
Single Pedestal 60in X 3. 1
Filing Cabinet - 2 Drawers 1

No 1 D1-608/B
I I (=T
No 3 C2-230/G
4
3

No
No

D2613/B
F1-265/B

Yes 1
Yo | 1]
Yes 1
Yes
Yes

Select All Select None Drop Ship

Il I ]

To drop ship items:

e Click the Drop Ship button to display the Drop Ship form.

Choose the first drop ship address and items
e Pick a shipment address.

[ ]
selected address.

Choose the second drop ship address and ite
[ ]

e Double-click the Include column (select “Yes’

address.

TaiRox Productivity Tools for Sage 300
© 2009-2024 TaiRox Software Inc. All rights reserved.

Double-click the Include column (select “Yes”

) for each item that you want to drop ship to the

Click the Drop Ship button on the form to update the PO entry window with the selected items.

ms

Select another shipment address to drop ship other items on the PO to a different location.

") for each item that you want to drop ship to the new

Click the Drop Ship button on the form to update the PO entry window with the selected items.

Press Cancel when done to return to the main PO entry window.
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Extended PO Entry Using the Line Finder

Using the Line Finder

The Extended PO Entry Line Finder window lets you quickly find any PO detail line in a large order by
item number, location, order number, or vendor item number.

Click the Line Finder button to display the Line Finder pop up window.

e Choose the order to display PO items in the Line Finder.

You can list items by item number, location, vendor item number, or order number. The example
below displays lines by item number.

e Choose the selection criteria for displaying PO items in the Line Finder.

You can select items by item number, location, vendor item number, or order number. The
example below selects item lines using a range of item numbers and the location.

e Click the Load button to display the selected lines.

e Double-click the line you want to view, or highlight the line and click the Select button at the
bottom of the screen.

s ™
) SAMLTD - Purchase Order Lines b [
File Help
Order By
Select Order By
ttem Number -
(Mone) -
(Mone) -
Select tems By From Ta
kem Number ~ [mamn | [p14000 |Q
Location - |2 | Q |2 | o]
(Mone) -
ltem Mumber ~  Contains - | | [ Load ]
Line Mumber | tem Mumber | kem Description Urit of Meas... Unit Cost | Exdended Cost
23 | A1-310/0 | 23.500000 587.50 0)
21 A1-320/0 50W/12V Halogen Bulb 2 30.0000 Ea 3.330000 101.70 0
25 A1-400/0 Desk Note Book 2 50.0000 Ea 7.250000 362.50 0
4 11 ] r
CGty.OnHand Gty On Sales Order  Gty. On Purchase Order Gty. Committed Gty. Available
Location 2 (Ea) 165 0™ 25 [0 0 165
All Locations (Fa.) 443 52 [H 815 [2 0 443
Soue
S
TaiRox Productivity Tools for Sage 300 19
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Extended PO Entry Purchasing from History

Purchasing from History

The Purchase from History window lets you quickly create new purchase orders for a vendor based on
previous vendor purchases.

Using Purchase from History also tends to consolidate multiple orders into single, larger orders, resulting
in lower shipping costs, increased discounts and other operational efficiencies.

Click the Purchase From History button to display the pop up window. [F'urchase From Histnr:-'...]

. .
# PTDEMO - Extended PO Entry [

File Help

Furchase Orders ~ Purchase History

Purchase Order Range

Select Purchase Orders By From To

o) -
(None) -

o) -

[B Purchase Order Mumber | Purchase Order D Bill-To Location 5hip-To Location Description

Row | Include Include Comments Include Instructions | [H kem Number ltem Description Location | Order UOM | Quantity Orderec|

4 1 | +
Gty.OnHand  Qty. On Sales Order Gty On Purchase Order Qty. Committed Gty. Available
Location 1] 0 0 0 0
Al Locations 1] 0 0 0 0
Load Select Al Select None Purchase

e The Purchase Orders tab lets you apply selection criteria and then press the Load button to
request previous purchase orders.

e The Purchase History tab is similar, but lets you select using item criteria rather than order
criteria.
To create a new PO from prior ones using the Purchase Orders tab

e Use the Purchase Order range fields to select past POs for the vendor, and then click the Load
button. In this case, we’ve chosen purchase orders since January 1, 2019. (You can add or
remove fields from the range field dropdown lists using the Field Settings button — see below.)

Purchase Orders  Purchase History

Purchase Order Range

Select Purchase Crders By From To

Purchase Order Date - [pi1/201s | g [12/31/9998 |# [ Addtional Giteria.. |
(None} -

(None) - Field Settings...

[8 Purchase Order Number | Purchase Order D.. Bill-To Location Ship-To Location Description

POODDO00D10 1/8/2019

FOO00000D0S 1787219

POOD0000D08 17872019

POODOOO0DOT 1/8/2019

e Click the purchase orders lines to see the PO details in the bottom grid.

TaiRox Productivity Tools for Sage 300 20
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Extended PO Entry Purchasing from History

e Click the Select All and Select None buttons to include all or none of the items in the previous
purchase order.

e Double-click the Include column to select individual lines (the Include column displays Yes).

Ling Num... | Include | Include Comments | Include Instructions | [B tem Number ltem Description Location | Order UOM | Guantity Orjiisd
1 No A1-400/0 Desk MNote Book 4 Ea. L
2 AT-401/0 Desk Calendar .. 1
3 __I-___
4 No No A1-470/0 Dry-erase White ... 4
R MNn M Mry A1-RRMAN Hinhlinhtar 4 Fa i
4| [ | +

e Edit the Qty. Ordered column to change the quantities for the new purchase order that you are
creating. (The Quantity Ordered field shows the quantities from the previous PO.)

Include Comments | Include Instructions | [B) kem Number ltem Description Location | Order UOM
No No A1-400/0 Desk MNote Book 4 Ea. ZDD D L
A1-401/0 Desk Calendar .. 4 1
_I-_-_I m
A1-470/0 Dry-erase White ... 4
Nn Nn A1-RROAN Hinhlinhter 4 Fa RN (T | |

< [ [l | +

e When you have finished the edits for items from this purchase order, click the Purchase button to
add the items to the new PO.

e Select another purchase order from the top grid, choose the items that you want to order, enter
the new quantities, and again click Purchase.

¢ Click the Close button when you have finished adding items from prior POs.

Use the “Field Settings” button to customize the list of fields for selecting POs:

Click the Field Settings button to change the fields that appear in the “Select Purchase Orders By”
dropdown lists on the Purchase From History screen.

% PTDEMO - Extended PO Entry (=[E] = ]

File Help

Purchase Orders ~ Purchase History

J % PTDEMO - Extended PO Entry Field Settings =)
Pucize Due e
| [Tems Code Purchase Order Date Addtion Gikeia
| | |Bill-To Location < Exclude Ship-To Location
Purchase Order Type Field Settings
Completad
On Hold
Tecom e [
Ertered By

Order UOM | Guantity Orderec|

&

e The list of fields on the right are the fields that will appear in the Select Purchase Orders By
dropdown.

e To add a field to the dropdown list, select it in the list on the left, and click the Include button.
Using the Purchase History tab

The Purchase History tab allows a similar sequence of operations — selection, editing of quantities and
copying to the purchase order.

TaiRox Productivity Tools for Sage 300 21
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Extended PO Entry Purchasing from History

% PTDEMO - Extended PO Entry == ==

Eile Help

Purchase Orders  Purchase History

ltem Range

Select ltems By From To

Jrem Nomber] + [A14000 Q | | ¢ [ Additional Criteria

{Mone) -

{Mone) -

Include | [B tem Mumber | kem Description [8 Invoice Mumber

No A1-401/0 Desk Calendar ... IN158115 5/5/2020 1 Ea 10 1]

No A1-401/0 Desk Calendar ... IN158125 5/10/2020 1 Ea 12 (1]

No A1-401/0 Desk Calendar ... IN158135 6/23/2020 1 Ea 12 (1]

Gty.On Hand  Qty. On Sales Order  Gty. On Purchase Order Cty. Committed Qty. Available
Location 1 (Ea.) 184 08 200 [E 0 184
Al Locations (Ea.) 579 o[d 800 [H 0 579
Load ][ SelectAl ][ SelciNone |[ Puchase |

e Select the range of item numbers, invoices, or transaction dates that you want to use as search
criteria, then click the Load button.

e See the steps listed above for including items from history on the new purchase order.

Setting default descriptions, comments and instructions for included items

You can select the default settings for taking descriptions, comments and instructions from the original
purchase orders. You can also change the settings for each item as you select them.

e Select File > Settings from the Purchase From History screen.

% PTDEMO - Extended PO Entry Settings (=25

[7] Use description from selected line for detail description
[ Include comments for each selected line
[ Include instructions for each selected line

e Select the checkboxes if you want them to be included by default from the original purchase
orders.

TaiRox Productivity Tools for Sage 300
© 2009-2024 TaiRox Software Inc. All rights reserved.
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Extended PO Entry Viewing Prepayments

Viewing Prepayments

The Prepayments window lets you quickly view any prepayments entered for the current vendor and
purchase order.

Click the Prepayments button to display the pop up window. [ Prepayments... ]

In the following example, the program displays a single prepayment that was entered in A/P and assigned
to PO number “45” for Grant Office Supplies.

rotabe |14 4 PSR J» 1 Q + oty O
Order  Taxes Optional Fields Rates Totals “ Required
-
Prepayments
FO Date [p22-12:08 FOE  Vandor Number 1580 | Grant Ofc Supplies

Purchase Order Number

Ship-To Location

Bil-To Location

Description

PO0000DD045

Payment Date | Posting Date

2022-05-10 2022-12-05

Vendor . "smency Code | Vendor Remit-To Location | Ve

UsD

Vendor Acct, Set * [USA \Accour

Description ttems for Black - December 2022

ftem De : A
A1-751/B 1.440.00

2 No 51-200/B Hat Scr 124121
3 No 51-300/Y Curved 112500

5,000.00 | 60

P

>

v
>

b

Total

Amount Remaining
tem/Tax... | | Cae. Taxes | | Consolidate

Post Delete History.. | | Purchase From History... Prepayments... / Close
Gty.OnHand Gty On Sales Order  Gty. On Purchase Onder Gty. Committed Qty. Available
Location 1 (Ea.) 0 120 [ 120 [8 Q 0
All Locations (Ea.) 3 120 [4 120 (4 [1] 3
Database 1D Description tem Number o
SAMING Sample Comgan... 1 Central warehou...  A1751/B Stapler -Kings 5. Ea. [ ] [ [] ]
SAMING Sample Compan... 2 Potland Office ~ A1-751/B Stapler -Kings 5., Ea. 3 0 0 E 0 v
< >

The “Amount Remaining” indicates the amount of the prepayment that has not been applied to an invoice
with a matching purchase order number.

TaiRox Productivity Tools for Sage 300 23
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Extended PO Entry Quick PJC Entry

Quick PJC Entry

To speed up data entry, Extended PO Entry will default inserted lines to the previous entry's selections for
Contract, Project and Category when multiple lines use the same selections.

The following form shows how the order form appears immediately after pressing the Insert key to create
the second line (with default values for the Contract, Project, Category and Cost Class fields):

SAMLTD - Extended PO Entry

File  Help  P/O Purchase Order Entry

[ POMNumber |14 4 [FREWT [» ¥ Q+ EteedBy | |
Vendortumber 1580 |0 4 gl [&)  [Grant Offce Suppies lastRecopiho. [ |
"Order | Taxes | Optional Fields | Fiates  Totals * Required
Tt |:| ) [C] From Requisition ) [710n Hold Job Related

Optional Field

FO Date 12/06/2022 FOE Paint | Anival Date Miscellaneous Expense Purchases  Miscella
Discount onn goods -not labour

FO Type Active - 20

StpTolocsion | | bl SV [ |Q |

Bil-To Location |:| Q B Temscoder PUETEL | [Peby voice Date

Vendor Acct. Set * |u5A | Q ‘Ac:nunts payable, Cther

Description [ | Reference |

i I r

Completed | Q Contract . Q Category Cost Class Q ttem Number | tem Description Q, Location
No 120-1200-10 1012 UPGRLABOR Labor 100070 Embleton, Robert Wison 1 No 10 HOUR 52090
L lweeroeo w2 JweGRLABOR Jiebor [ [ | x| ol [ oo
O
[ [ ] | [x]
Consoldate [ SetAmvaiDate | [ Setlocaion | [ Update.. | [ kemFrder. | | Drep Shi. Order Subtotal
Post Deeie | [ Histong. | [Purchase From History.. | | Prepzyments..
Gty.OnHand  Gly. On Sales Order  Gty. On Purchass Order GQty. Committed Giy. Avaible
Location (1] (1] o (1] (1]
Al Locations (1] (1] o (1] (1]
TaiRox Productivity Tools for Sage 300 24
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